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About Sputnik GIS

Sputnik GIS - professional drone surveying software for engineers, surveyors and urban planers.

Sputnik GIS is an efficient software, designed for surveyors, engineers and urban planners to get the best
from aerial surveys. System supports common data sources, like vector and raster maps, point clouds, 3D
models, tiled 3D models, photos captured by drone, etc.

Software may be applied in such industries as construction management, monitoring and inspection, min-
ing, urban planning, oil and gas, emergency management.

2019 © Geoscan

www.geoscan.aero
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CHAPTER1

System requirements

Minimum configuration:

• Windows 7, 8, 10 (64-bit), Linux (Mint, Ubuntu), Mac OS

• CPU: Intel Core i3

• 1 GB of disk space

• 4GB RAM

• Video card: Nvidia, AMD, Intel HD 4000 and newer, 1GB VRAM, OpenGL 2.1 support

Recommended configuration:

• Windows 7, 8, 10 (64-bit), Linux (Mint, Ubuntu), Mac OS

• CPU: Intel Core i5 / i7 and better

• 1 GB of disk space

• 8GB RAM

• Video card: Nvidia, AMD, 1GB VRAM, OpenGL 2.1 support
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CHAPTER2

Installation

Spuntik GIS is distributed for Windows, MacOS and Linux operating systems. Follow the installation in-
structions for your operating system to complete the installation.

2.1 Windows

1. Run Sputnik GIS installation package (administrator privileges are required).

2. Follow the onscreen intructions to complete the setup .

3. After installation is finished, KML, KMZ, OC3 and TLS files will be associated with Sputnik GIS.

4. To start the application choose Start > Sputnik.

5. In case of issues during instalation process, read Troubleshooting chapter.

Attention: You need to have administrator privileges to install Sputnik GIS and license driver. Soft-
ware may work incorrectly if installed without administrator privileges.

2.2 Linux

1. Run Sputnik GIS installation package in Terminal from name Super user.

2. Follow the onscreen intructions to complete the setup.

3. After installation is finished, KML, KMZ, OC3 and TLS files will be associated with Sputnik GIS

4. To start the application choose Sputnik.

5. In case of issues during instalation process, read Troubleshooting chapter.

3
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2.3 MacOS

1. Unpack the file format *.dmg containing the installation file of the Sputnik GIS.

2. Run Sputnik GIS installation package.

3. Follow the onscreen intructions to complete the setup.

4. After installation is finished, KML, KMZ, OC3 and TLS files will be associated with Sputnik GIS

5. To start the application choose Sputnik.

6. In case of issues during instalation process, read Troubleshooting chapter.

4 Chapter 2. Installation



CHAPTER3

Activation

3.1 Online activation

To activate Sputnik GIS via Internet:

1. Make sure your Internet connection is functional.

2. Start Sputnik GIS, use Activation… command fromHelpmenu.

3. Paste your license key to Enter the product key input filed and click Activate.

Important: In case activation fails, check your key format. Proper format looks like: XXXXXXXX-XXXX-
XXXX-XXXX-XXXXXXXXXXXX

3.2 Offline activation

Important: You need to use additional PC with Internet access to activate Sputnik GIS on PC without
Internet access.

To activate Sputnik GIS on PC without Internet access:

1. Download offline activation utility

2. Start RUS utility on PC with Sputnik GIS installed. In the Collect Status Information tab check
Installation of newprotection key option and clickCollect information button. In theCollect
information dialog box, set the name and path to save *.c2v file.

3. Start web-browser on PC with Internet access and open the Customer login link

4. Log in to the Activation service using your license key a password

5. SelectOffline Activation option.

5
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6. Upload *.c2v file and click Generate button, *.v2c file will be generated.

7. Open RUC utility on PC with Sputnik GIS installed. In Apply License File tab select *.v2c file and
click Apply license button.

3.3 Activation in case of OS reinstalling

To activate Sputnik Agro after OS re-installation, follow these steps:

1. First you need to get *.v2c key. Open License activation link in your web browser and use your license
key as login.

2. On the user registration page fill the information or click Register later

3. Click View button in the Previous Activationmenu.

4. In the generated keysmenu click V2C File. It will be downloaded.

5. Open Check-in link in your web-browser, select you *.v2c file and click Apply button.

6 Chapter 3. Activation
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CHAPTER4

User Interface

4.1 GUI

Spuntik GIS GUI consists of:

• Main menu

• Toolbar

• Layers and objects window

• Properties window

• Map window

• Background jobs window

7
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4.2 Hotkeys

Action Hotkey
Open file Ctrl +O
Undo Ctrl + Z
Redo Ctrl + Y
Delete Delete
Select all Ctrl + A
Clear selection CTRL +D
Fullscreen F11
Rectangular selection Ctrl + R
Reset view to northup N
Reset angle totop-down view and rotate map to north-up viewр R

8 Chapter 4. User Interface



CHAPTER5

Navigation

Scaling (zoom in/zoom out)

Moving (globe rotation around its center)

Clockwise / Counterclockwise rotation (globe rotation around the point on its surface)

Changing the vertical angle of the view (globe rotation around the point on its surface)

Inspecting high-altitude objects (Moving along high object)

9
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Inspecting high-altitude objects (Moving along high object)

10 Chapter 5. Navigation



CHAPTER6

Project

Work with different datasets can be simplified by switching between Sputnik GIS projects. Every project
automatically stores a set of parameters:

• List of maps and drawings, loaded by user

• Last position of the 3D Map window camera

• Location, visibility and size of UI objects

6.1 Projects management

To create new project choose Project command fromNew submenu of Filemenu.

To open existing project choose Project command fromOpen submenu of Filemenu.

To open recent project choose one of available projects from Recent projects submenu of Filemenu.

To import any type of data into the project choose File command fromOpen submenu of the Filemenu.

6.2 Additional information

By default, imported raster maps are aligned with default SRTM elevation model. SRTM terrain data has
90 m spatial resolution and vertical accuracy about 1 m. Level of details can be increased by loading а local
DEM.

Sputnik GIS navigation tools can rotate the viewpoint around the object.

Visualization priority is set from top to bottom in Layers and Objects window. Last opned objects are
inserted in the lowes part of the list.

Use checkboxes in the Layers and Objects list to turn layers visibility on and off.

11



CHAPTER7

Data sources

7.1 Raster maps

Sputnik GIS supports the following raster map extensions: *.tiff, *.ecw, *.jpg, *.kmz and elevation models
extensions:*.tiff и *.kmz. Read more about working with raster map in chapter Raster_tools

7.2 Vector maps

Sputnik GIS supports the following raster map formats: *.shp и *.kml. Readmore about working with *.kml
in chapter KML tools, about working with *.shp in chapter Shapefiles tools.

7.3 3D models and point clouds

Sputnik GIS supports the following 3D models and point clouds formats: *.3ds, *.dae, *.obj,*.tls. ,*.las ,
*.oc3. Read more about working with 3D models in chapter 3D models tools, about working with *.tls in
chapter Tiled models, about working with point clouds in chapter Point cloud tools.

7.4 Drawings

Sputnik GIS supports drawings in *.dxf format. It is not available to import *.dxf file into project as a map
layers and view it in theMapwindow. You can view *.dxf files in 2DDrawings viewer . Read more about
working with *.dxf in chapter Drawings tools.

12
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7.5 WMS/WMTS/TLS services

Sputnik GIS supports importing data from WMS and WMTS services with feature request option and *.tls
models from Spuntik Web service. Read more about working with WMS/WMTS/TLS services in chapter
WMS.WMTS.TLS_tools.

7.6 Aerial survey

Spuntik GIS have number of tools for working with aerial imagery and UAV telemetry data:

• Visualisation of aerial survey telemetry in theMap window

• Viewing images in Image viwer

• Searching for images covering given point on the map

• Projecting aerial images on map

You need to have aerial survey telemetry file in *.txt format to be able to analyze it. Readmore about working
with survey data in chapterWorking with UAV telemetry files.

7.5. WMS/WMTS/TLS services 13



CHAPTER8

Measurement tools

8.1 Ruler

Ruler tool displays distance between two points on the surface.

To measure distance with Ruller click icon in the toolbar, then select two points on the surface to

measure the distance between them. Or select existing line and click on icon in the toolbar to measure
its length.

It is possible to change the position of selected point. Click once at a point, then drag it by the surface.

When length for polygon ismeasured, its value is saved to polygon extended data, you can use Information
tool to display the volume value when you need.

8.2 Corner ruler

Corner ruler tool displays slope, horizontal distance, actual distance and elevation between two points
located on surface.

14
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To perform measurements with Corner ruler click on icon in the toolbar, then select two points on
the surface to perform measurements.

8.3 Area

Area tool displays area of a polygon on the modelled surface.

To measure area of polygon click on icon in the toolbar and draw a polygon. Or select existing polygon

and click on icon in the toolbar.

Important: Depending on the area measured,the result can be displayed in square meters, hectares or
square kilometers. Area can be calculated on a plane or DEM surface.

When area of polygon ismeasured, its value is saved to polygon extended data. You can use Information
tool to display the area value when you need.

8.3. Area 15
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8.4 Volume

Volume tool calculates the volume of an area of DEM.

To calculate volume click on icon in the toolbar and draw a polygon. Or select existing polygon and click
on icon in the toolbar.

Important: In case there is only one DEM in the Layers and Objects list,

Sputnik GIS uses that DEM for measurements. Otherwise, it is necessary to drag and drop selected DEM
fromMaps folder toMeasurements > Volume object.

When volume for polygon is measured, its value is saved to polygon extended data. You can use Infor-
mation tool to display the volume value when you need.

8.5 Volume difference

Volumedifference tool calculates the difference between twoDEMsof the similar area, capturedwith
a time interval. It is possible to calculate cut and fill volumes and highlight the areas that have changed.

To calculate volume difference between two DEMs click on the icon on the toolbar and then draw a
polygon tomeasure the volume difference. Select Initial DEM and final DEM bymoving it fromMaps folder
toMeasurements > Volume difference.

Some parameters can be set before the calculation begins:

• Difference threshold (altitude difference between one point of two different DEMs to be included into
calculation);

16 Chapter 8. Measurement tools
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• Calculation step or turn «best» on.

The less the values of the calculation step and the difference threshold, the more time is required for calcu-
lation. Press Calculate button when setup is finished. After calculation is finished, you can see the result
in the Fill and Cut fields in the Properties window.

When volume difference for polygon is measured, its value is saved to polygon extended data. You can use

Information tool to display the volume value when you need.

8.5. Volume difference 17



CHAPTER9

Survey

9.1 Contour lines

Contour lines allows to calculate contour lines for given area on DEM.

To start contour lines calculation choose tool from Toolsmenu and delineate area to calculate contour
lines within it. Set upContour interval andDEMresolution in thePropertieswindow and clickCalculate
button.

18
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9.2 Cross section

Cross section allows to generate cross section for given baseline in *.dxf fromat.

To start cross section generation choose tool from Sections sub-menu of Tools menu and draw a
baseline. Set upCalculation step andAltitudemode in thePropertieswindow and clickCalculate button.
In the Save dialog box select the name and directory to save the output and format and click Save button.
It is available to generate cross section in *.dxf, *.csv and *.txt formats.

After section generation is finished, it will be displayed in theDrawing viewer window.

9.3 Cross sections

Cross sections allows to generate custom set of cross sections perpendicular to given baseline and
aligned to the left and to the right of the baseline by half of the section width value.

To start cross sections generation, choose tool from Section submenu of Toolsmenu and draw a base-
line. Set up Calculation step, Distance between the sections, Section width and Altitude mode in the Prop-
erties window and click Calculate button. In the Save dialog box set up the name, format and directory
to save the output, and click Save button. It is available to generate cross sections in *.dxf, *.csv and *.txt
formats.

9.2. Cross section 19
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9.4 Section comparing

Compare sections and Compare cross sections tools allows to generate cross section or set of cross
sections for multiple DEMs on one *.dxf drawing.

To start sections comparing choose one available section comparing tools from Sections submenu of tools
menu and draw a baseline. Set up parameters in the Properties window and click Calculate button. In
the Calculate sections for elevation models window select elevation model to calculate sections for,
set up the name and directory to save the output and format.

20 Chapter 9. Survey
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9.5 Slope map

Slope map tool allows to calculate slope map for given area on DEM.

To start slope map calculation choose tool from Tools menu and draw the polygon to calculate the
slope map within it. In the Properties window set up color palette for the slope map and click Calculate
button. In the Calculate slope maps window select elevation model to calculate slope maps for, names
and formats for the output and click OK

9.5. Slope map 21
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Note: It is posible to change default slope map color palette. To do that, choose Preferences command
fromSettingsmenu, in thePreferenceswindow switch toSlopemap tab and set the default color palette
parameters.

9.6 Kriging interpolation

Kriging interpolation allows to build elevation model from given set of points.

To start building elevationmodel choose command fromEdit relief submenu of Toolsmenu and draw
a polygon to build elevation model within it. Import *.kml file with points into Sputnik GIS and drag it from
Maps folder into Kriging interpolation node. In the Properties window set up the Variogram model
and other parameters if needed, click Calculate button.

In case you have points coordinates in *.txt file, create empty polyline, right-click on and choose Edit co-
ordinates.. command. In the Edit coordinates window select coordinates reference system and paste
coordinates from *.txt file. To create points from polyline, right-click on it and choose Create points..
command.

22 Chapter 9. Survey



Sputnik GIS
user manual, Release 1.4

Important: Keep inmind that vertical datum, used for altitudemeasurements in *.kml files is theWGS84
EGM96 Geoid.

9.7 Relief editor

Relief editor tool allows to edit elevation models. Relief editor tool may be used to build DEM from
DSM by deleting buildings and other objects, the other usage scenario is to model new surface features.

To start relief editing choose command from from Edit relief submenu of Toolsmenu. Now you can
draw polygons to delineate relief feature you want to modify. Double click to finish polygon drawing and

start to draw the next one. To finish polygon drawing click button on the toolbar or pressEnter button.

In case you need to delete features from surface - just delineate them with polygons, the part of elevation
model within given polygons will be interpolated with respect to polygons node.

In case you need to model new surface feature - draw it as polygon and set the needed elevation for each
polygon node using Coordinates editor.

Before starting calculation choose if you want to edit current file or create a copy of it and click Calculate
button.
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9.8 TIN model

Calculate TIN model allows to convert surface model from *.tiff or *.kmz formats into *.dxf format.
TIN model is a surface model in the form of a network of adjacent non-interesting triangular faces, defined
by the nodes and edges that cover the surface.

To generate TINmodel of surface chooseCalculate TINmodel tool fromToolsmenu and draw a polygon
to generate TIN model within it.

In the Propertieswindow set up .dem files to generate TINmodel for, .prj file to reproject TINmodel, TIN
model accuracy and Step parameters and click Calculate button. The Quick calculation option reduces
processing time, but makes the model rough. To get the exact model, uncheck this option.
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CHAPTER10

Modeling

10.1 Daylight

Daylight tool allows to visualise daylight for given area, at given date and time.

To start daylightmodeling, selectDaylight command fromViewmenu. In theDaylightwindowand check
Enabled box. You can set date and time for daylight modeling using Time widget, date using Date widget
and time zone using Time zone widget. To set the current date and time, click Current time button. To

start time animation set the Speed parameter and click button.
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10.2 Visibility area

Visibility area tool allows to model and export visibility area from given point on model.

To start visibility area modeling, choose from Toolsmenu and set the start point in theMap window.
To change visibility area position, click it in theMap window and drag. To change visibility area altitude,
press Shift button and drag it.

You can set the parameters for Visibility area tool in the Properties window. To export visibility area
in *.tiff format, right-click it in the Layers and objects window and choose Save as… command. In the
Save visibility area dialog box set the output resolution and clickSave button. In case Import into project
box is checked, the output *.tiff file will be imported into project.

10.3 Observation point

Observation point tool allows to model view from given point on the model and binding image to it.

To start observation modeling, choose from Tools menu and set the observation point in the Map
window. To change observation point position click it in theMapwindowanddrag it. To change observation
point altitude, press Shift button and drag it. To switch to first person view from observation point, right-
click it and choose CCTV view.
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You can set the parameters forObservation point tool in the Properties window. To attach an image to
observation point select an image in the Propertieswindow. To project attached image to the model, right
click on the observation point and choose Bind to image.
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Presentation

11.1 Screenshot

Screenshot tool allows to create high resolution screenshots of 3Dmodels and other data imported into
the project.

To create screenshot choose one of available resolutions orCustom size command from Screenshot sub-
menu of the Presentationmenu. To take screenshot click Take screenshot button in theMap window.
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11.2 Video tour

Tour tool allows to create video tour around the 3D model, or other data imported into the project,

and render it in high resolution. To start video tour creation click icon on the toolbar. To save current

view as key position click icon on the toolbar, to create delay click icon on the toolbar. You can
change key position parameters and delay parameters in the Properties window. Location of key position
can be changed in theMap window, to do that drag key position node in theMap window. To change key
position altitude, press Shift button and drag it.

To play video tour use and buttons on the toolbar. To render a video from video tour right-click
the tour in the Layers and objects window and choose Video recording… command. In the Video
settings window set rendering parameters and click Record… button.

11.3 Animated track

Track tool allows to create animated track for 3D model.

To start animated track creation chooseRecord a track command from Presentationmenu and draw a
trajectory of track. To attach 3Dmodel to track, set it in the Propertieswindow, other parameters of track
are available in the Properties window as well.

To play animated track use and buttons on the toolbar.
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Note: Video tourmay be combined with animated track. To render an animated video from video tour and
track, create new folder and drag and drop tour and track objects into it. Than right-click the folder in the
Layers and objects window and choose Video recording… command.
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Special tool

12.1 Creating a Grid

The Grid tool is used to create a regular grid with indexed cells.

To create a grid in Layers and objectswindow, select *.kml file containing a polygon bounding region for
the grid. Select Create grid from Tools menu. In the dialog box, set the grid size in kilometers. Specify
the path to save the result and pressOK.

32



Sputnik GIS
user manual, Release 1.4

Note: To select several squares from the grid, hold down the Ctlr key and then click the square in the grid
one by one.

12.2 Camera-antenna correction

The program GIS Sputnik the ability to correct the distance between the antenna and the onboard GPS
receiver UAV. For correction, add a text document with the coordinates of the photo centers. In Tools
section, select Camera-antenna correction. Camera-antenna correction is also available in the context
menu of the file. In theMap window that appears, specify the necessary correction parameters.

Important: the Suffix is added automatically by the program, if it does not appear, use _corrected.

12.3 Work with a GPS receiver

GPS connection preferences are set to GPS receiver functions. Select Preferences from Settings menu.
GPS receiver settings are usually specified in themanual of the receivermodel. If the parameters are known,
they are entered in the program window Parameters in the section GPS. The GIS Sputnik takes into ac-
count the following parameters:

• Port,

• Baud rate,

• Data Bits,

• Parity,
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• Stop Bits.

Important: The program allows you to visualize the moving GPS receiver on the Map. Select Follow
GPS command from Viewmenu. Map window will display the movement of the device.

12.4 Align maps

In the GIS Sputnik program, a tool for Align maps relative to each other is implemented. You need to
load orthophotos intoMap window. In Toolsmenu, select Align maps.

In Layers and objects window, click one of the orthophotos, then select a point on Map and click the
left mouse button. Red point-shaped marker will appear. Select the corresponding point on the second
orthophoto. After that, the shift of the second card will be calculated and it will be shifted to the required
distance.
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Note: You can shift the orthophoto in thePropertieswindowof the selected orthophoto. Shift parameters
can be set:

• by height,

• by direction (South-North and West-East).
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Raster maps

13.1 Optimisation and re-projection

To speed up the rendering of raster maps in *.tiff format needs to optimize them. In some cases you may
need also to reproject raster map into other coordinate reference system.

To optimise or reproject raster map chose Raster map command from Import submenu of File menu.
In Import raster map window select the raster or several rasters and click Next button. Check the Op-
timize box for optimisation. To reproject raster map into other coordinate system double click on it, in the
Coordinate systems window select one of available coordinate systems and click OK button. To finish
import procedure, click OK button.

13.2 Visualisation

Sputnik GIS allows several visualisation modes for raster maps:

• Single band

• Multi-band mode

• Color palette

Sputnik GIS supports working with such types of raster maps as:
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Map type Number of chan-
nels

Stored value
type

The default display

Multispectral images > 3 int the image in the natural or pseudo
color

RGB raster maps 3 int the image in the natural color
Height map
(DEM/DSM)

1 float relief

Other single-band
rasters

1 float relief

Other single-band
rasters

1 int monochrome image

To change raster map visualisation med click Additional properties in the Properties window. In the
Additional properties window switch to Visualisation tab and set up visualisation mode.

13.2.1 Single band mode

Single bandmode is a defaultmode for 1 or 2 bands rastermaps. Youmay set upwhich bandwill be visualised
in theMap window.

This mode is the defaultmode for displaying single-band rasters when file loaded into the program.

To switch to this mode, in the drop-down listVisualizationmode select Single-Channel. In this mode,
You can set the Max and Min thresholds of values to display.

Important: This mode can also be used to display a single channel of a multiband raster.

13.2.2 Multi-band mode

Multi-band mode is a default mode for 3 or > 3 bands raster maps. You may set up which bands will be
interpreted as Red, Green, Blue bands and visualise raster map in pseudo color mode.

To switch to this mode, in the drop-down list Visualization mode selectMulti-Bands.

13.2.3 Palettes

Palettes is a default visualisation mode for any type of raster map. You may use it with any type of raster
map to style one of its bands.

To switch to this mode, in the drop-down list Visualization mode select Palettes.

There are three palette-setting mode in Sputnik GIS:

• Stretch

Set band, color scheme and additional parameters and click OK button to finish.To set off the palette
right-click raster map in the Layers and objects window and choseDefault command from Show
asmenu.
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You can save your palette for this section Color scheme select Save as... The palette will be saved
in *.xml format.

• Classify

Select band, number of classes and color scheme. Set additional parameters and click OK button to
finish.

Important: Check Relative box to translate the raster values to relative mode (from 0 to 1). If raster
has a float type values, it will be interpreted as elevation model. CheckHide elevation box to interpret
raster map as image.
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You can save your palette for this section Color scheme select Save as... The palette will be saved
in *.xml format.

• Templates

You can create or load templates. To create templates, click Table and select Add to templates….
The file will be added to the list of existing templates.

To load palette in the Template section, select Load… from the context menu. The added palette
can be edited and saved to a new file. Select the Save as… in the context menu of the section Table.
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13.3 Magic wand

Magic wand allows to vectorise objects and on raster map in semi-automatical mode.

To start vectorisation choose icon from Toolsmenu and click on the object of your interest in theMap
window. When Magic wand tool is active you may set its parameters in the toolbar. Change Threshold
value - to increase or decrease the vectorization zone. The Approximation parameter is responsible for the
number of nodes in the polygon.
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Note: Keep Ctrl button pressed when using magic wand to automaticly merge new polygons with old.
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KML tools

14.1 Geometry creation

Sputnik GIS allows to perform basic edit operations for *.kml files. To create new *.kml file choose KML
command fromNew submenu of Filemenu.

New *.kml file will be opened in edit mode. When edit mode for *.kml file activated a set of specific tools
appears in the toolbar:

Icon Tool

Create Point

Create line

Create ring

Create polygon

14.2 Editing

To open *.kml in editmode select it in theLayers andobjectswindow and chooseOpeneditor command
from context menu.

To edit geometry node, click left mouse button on it in theMap window and drag.
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To edit coordinates of geometry manually, select it and chooseEdit coordinates.. command from context
menu.

In Edit coordinate dialog box it is available to:

• change separated node coordinates

• set the elevation for all geometry nodes

• set the coordinate represetation mode

14.3 Style

To configure geometry style, select it in the Layers and objects window and cnofigure style properties in
the Properties window.

When several geometries are selected, you can configure common style for all selected geometries.

When folder or multigeometry is selected, you can configure common style for all geometries inside folder
or multigeometry.
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14.4 Geometry visualisation properties

Sputnik GIS tools allow to draw 2D and 3D geometry objects.

Three altitude modes for geometries are available:

• clampToGround / clampToSeaFloor;

• relativeToGround / relativeToSeaFloor ;

• absolute.

Default mode for geometry objects is clampToGround.

Example: clampToGround mode

Example: relativeToGround mode
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Example: absolute mode

To create 3D geometry objects (only available in absolute or relativeToGround mode) switch extrude mode.
To switch extrude mode of geometry object, choose Change extrude property in its context menu.
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Tessellation is a property of polygons and polylines that is responsible for the geometry drawing method in
three-dimensional space, the parameter value can be changed in the Properties window. If the value of
the parameter Tessellate is set to false, the geometry will be drawn as a single object and may fall under
the relief. If the value of the parameter Tessellate is set to true, the geometry will be divided into a set of
linear primitives and will lie on the relief.

14.5 Extended data and description

Each geometric object can contain attribute information, the *.kml format allows you to add a description
and extended data in the format “Name - Value” to the geometric primitive.

To add a description to the geometric object, select it in the window Layers and objects and click the
Description button in thePropertieswindow. In the window that appears, you can add a text description
of the geometric object, the description supports HTML markup.

To add extended data to the geometric object, select it in theLayers andObjectswindow and click theEx-
tendedData button in thePropertieswindow. In the window that appears, you can create new attributes
and set names and values.

To view a description of an object or its attributes, select the tool | inf | on the toolbar and click it on the
geometric object in the windowMap.

14.6 Geometry operation

Sputnik GIS has a wide range of tools to convert between different types of geometry and perform boolean
operations on two or more polygons

Select two ormore polygons in the Layers andObjectswindowor in the 3Dmapwindow, then call the context
menu by clicking right mouse button. You can perform the following operations:
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• Union – polygons dissolve into one polygon, or become a multigeometry feature if there are no com-
mon points.

• Intersect - only the common points are copied to the resulting polygon(s).

• Difference – the common points of the polygon(s) are subtracted from the first selected polygon.

• Symmetrical difference – only the non-common points are copied to the resulting polygon(s).

It is possible to transform geometry objects from one type to another:

from point from lines from ring from polygon
Create points + + +
Create line + - -
Create ring + + -
Create polygon + + +

To transform geometry objects form one type to another, select two or more objects in the Layers and
Objects window and choose one of available transformations in its context menu.

To create buffer, select geometry and choose Create buffer command from its context menu.

14.7 Export

It is available to export *.kml file into *.dxf and *.shp formats for futher usage in GIS and CAD applications.
To export *.kml file to *.dxf or *.shp choose Save as command from its context menu. In the Save dialog
box select name, format, and directory for output file. You can use *.prj file to set custom CRS for the output
*.dxf or *.shp file file.

When you export *.kml file containing more than one geometry type into *.shp fromat, select geometry
types you would like to export. Each geometry type will be exported in separated *.shp file. You can create
dictionary for attributes names. Click settings in the Export Kml to ShapeFile dialog box, set up names
for output attributes in the Conformity column and click Save dictionary. To use the dictionary created
earlier, click Apply dictionary.

14.7. Export 47



CHAPTER15

Shapefiles tools

Sputnik GIS support importing and visualisation of *.shp file and exporting *.kml files into *.shp format.
Know more about exporting *.kml file into *.shp in KML tools chapter. To open *.shp select File > Open
> File…. In the dialog box, specify the file type -*.shp. The file appears in theMap window.

15.1 Viewing attributes

To view *.shp file table of attributes right-click it and choose Show attributes. To switch between pages
of attributes table use Previous andNext buttons.
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15.2 Setting styles

To set up styles for *.shp file, right-click it and choose Shapes style… command. In the Shapes style…
window you may apply *.sld file to *.shp file. To apply *.sld file rightc-click on *.shp file in the Layers and
objects window and choose Shapes style.., in the Styles window click Apply SLD… button and select
proper *.sld.

To change style for condition, double-click on it in the Styles window and set up new style in the Style
editor window. To save new *.sld file, use Save as SLD button in the Styles window.

Note that the format specification is *.shp implies strict typing of the file by geometry type, different styles
are applied to different types of layers:

Layers Available style Available style Available style
Points Marker thickness Marker color •

Lines Line thickness Line color •

Lines Stroke thinckness Stroke color Fill color
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3D models tools

Spuntik GIS support 3D models in *.obj, *.3ds, *.dae extensions. It is available to view model inMap win-
dow, scale and change it’s orientation. To open 3D model in Sputnik GIS use File command from Open
submenu of the File menu. To change 3D model properties, select it in the Layers and objects window
and change properties in the Properties window.

Important: Imported model will be placed to the point marked by crosshair. Along with model, *.kml file
with spatial reference, scale and orientation data will be created.
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Tiled models

17.1 Exporting part of *.tls model

Export part of *.tls model tool allows to export part of 3D tiled model in *.tls form into *.3ds, *.obj,
*.dae format.

To export part of *.tls model choose command from TLS tools submenu of Tools menu and draw a
polygon to export part of model within it. In the Export part of TLS model window set up path for the
output, Quality, Format and click OK button.
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17.2 Masking *.tls model

Create TLS mask tool allows to mask part of *.tls model within given polygon.

To mask part of *.tls model choose command from TLS tools submenu of Tools menu and draw a
polygon to mask part of *.tl model within it. To reset mask right-click on it and choose Reset TLS Mask
command. To set mask properties right-click it and choose Properties of TLS mask.
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Point cloud tools

Sputnik GIS supports point clouds in *.las and *.oc3 formats.

The tools listed bellow may be used with point cloud:

• Ruller,

• Corner ruller,

• Area,

• Drawing *.kml geometries.

18.1 Lidar point clouds in *.las format

To import *.las file into Sputnik GIS choose File command from Open submenu of File menu. In some
cases *.las file have no proper information about coordinate reference system in it’s metadata. In this case
you can set it manually in the Properties window.

Two modes are available for point cloud visualisation: colors and classes. To change point cloud visualisa-
tion mode, right-click it and choose one of available mode from Viewmode submenu.

The point cloud is in the *.las format can not contain information about coordinate system, set the coor-
dinate system of the file manually. In the Properties window, select Advanced properties and set the
coordinate system in the dialog box. You can set the offset of the point cloud.
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18.2 Agisfot point clouds in *.oc3 format

To import *.oc3 file into Sputnik GIS choose File command fromOpen submenu of Filemenu.

Two modes are available for point cloud visualisation: colors and classes. To change point cloud visualisa-
tion mode, right-click it and choose one of available mode from Viewmode submenu.
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Drawings tools

Spuntik GIS support generation of *.dxf files and it’s visualisation in 2DDrawing viewer

You can export to *.dxf format any *.kml file, also such tools as: sections, cross sections, compare sections,
TIN model create output in *.dxf format. To import *.dxf into Sputnik GIS choose File command from
Open submenu of Filemenu. To open drawing in Drawing viewer double left-click on it in the Layers
and objects window.

You can perform measurements inDrawing viewer using corner ruler .
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WMS/WMTS/TLS services

20.1 WMS/WMTS services

WMS - Web Map Service WMTS - Web Map Tile Service

To import WMS or WMTS map chooseWMS/WMTS.. command from Import submenu of File menu.
In the ImportWebMap dialog box set up the url andAuthentication parameters if needed and clickNext
button. Than select needed layers and click Finish button.

It is available to get feature info from WMS/WMTS maps imported. To do that use tool on interested
feature.
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Due toWMTS support, you can use your own tile surfaces, createdwithMapbox service. To sue yourMapbox
tile surface, copy its link and paste it to URL-string inWebmap import window.

20.2 TLS service

TLS service - Sputnik Web TLS service: https://sputnik.geoscan.aero/

To import *.tls model from Sputnik Web service choose TLS.. command from Import submenu of File
menu. In the Import TLSMap dialog box set upAuthentication parameters for your SputnikWeb account
and clickNext button. Than select needed *.tls models and click Finish button.

Selected TLS model will be displayed inmap workspace.
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Working with UAV telemetry files

21.1 Aerial survey

SputnikGIS provides number of tools for aerial survey rawdata analysis. Toworkwith raw aerial survey data
you need to have images and *.txt file containing UAV telemetry in one folder. Image coordinates should be
in WGS 84 CRS.

To start woking with aerial survey choose File command from Open submenu of File menu and select
telemetry file in *.txt, *.tel.

21.2 Photo selection

To select aerial images covering given point on a map right-click on the map and choose Select photos
command. Selected photos will be displayed in the Photos window.

To open photo in the Photo viewer double-click it. If needed you may copy photos from Photos window
and paste them into other software.
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21.3 Image projection

To project image on surface right-click on it in theMap window choose Project photo command. To get
accurate photo projection you can bind it manually, to do that, right-click on photo in theMapwindow and
choose Bind to image command.

60 Chapter 21. Working with UAV telemetry files



Sputnik GIS
user manual, Release 1.4

21.4 Agisoft Photoscan/Metashape project creation

To create Agisoft Metashape project from aerial survey raw data right-click telemetry file in theLayers and
objects window and choose Create Photoscan/Metashape project.
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Coordinate reference systems

In Sputnik GIS it is available to set up coordinate reference system for current project. All data in the project
transforms to project coordinate reference system on the fly.

To set up project coordinate reference system choose one from Coordinate system submenu of the Set-
tingsmenu. To set up custom CRS, choose Custom CRS command from Coordinate system submenu
of the Settingsmenu. In Choose CRS dialog box, choose one of available CRS and click OK. To add cus-
tom CRS to the list of available CRS, click Load new PRG button, in the Load new PRJ file dialog box
select file and set CRS name, click OK.

Note: If you import raster map without CRS information in it’s metadata, or in case CRS information
in metadata is wrong you can set CRS for raster map manually in it’s properties window. In Properties
window click CRS button, in dialog box set up CRS for raster map.
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Preferences

Select Settings > Preferences in mainmenu. In this window, you can configure a number of user param-
eters to improve the interaction with the program.

Parameters Descriptions
DXF this page is for configuring DXF vector images (*.dxf), created when using the tools:

Sections, TIN model
GPS GPS connection preferences
KML setting up creation, viewing and working with *.kml files
Language choise language
NDVI visualiza-
tion

set the default palette for viewing NDVI maps

TLS perfor-
mance

adjust the balance between performance and display quality *.tls models

Tools this page is for configuring tools
Interface general interface settings. Setup single object dragging and location format
Slope map set the default palette for the draft Map tool
Cache is a folder for temporary data in the file system
Updates enable/disable update installation
Usage report-
ing

enable/disable the usage reporting of the Software

Error Report-
ing

setting up error reporting

Image viewer selecting an image viewer
Photo projec-
tions

setting the display of photo

Coordinate Sys-
tems

work with the database of coordinate systems

Tables tables settings
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Troubleshooting

24.1 Installation errors

The most probable cause of errors that appear during Sputnik GIS installation is a lack of administrator
privileges.

In case the error appears:

1. Abort the installation

2. Check whether you have sufficient level of administrator privileges

3. Run installation again

24.2 Startup errors

Startup errors occur because of licencing issues.

Follow these steps:

1. Checkwhether hardware key (USBdongle) is installed properly on the local PC or on the Licence Server

2. In case software key is used, check if the HASP driver is installed properly

Read more about license driver issues in chapter Administration.

24.3 Runtime errors

Two types of errors can occur during runtime:

1. Handled exceptions appear in the bottom right part of 3D Map window;

2. Unhandled exceptions appear in a separate window.
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In case of handled exception occur, the message box with instructions will appear in the bottom right part
of Map window.

In this kind of unhandled exceptions, please click on Send report button and write a short message to de-
scribe a sequence of actions performed before the error has appeared. It will take some time to analyze your
report and to update Sputnik GIS.

Important: You can also setup automated report sending or disable it. Go to Settings > Preferences…
enter contact information and select one of available options for error reporting.

We appreciate your help. Together, we make Sputnik GIS better!
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Changelog

25.1 Sputnik GIS version 1.4

25.1.1 New features

• EPSG CRS base

• User defined CRS support

• Relief editor

• Daylight modeling

• Observation points

• Visibility zones

• Photo projection

• Track animation

• Simultaneously tracks and tours animation

• Video rendering of animated tours, tours + tracks

• Sputnik Web connection - loading *.tls models

• *.shp files support

• *.las 1.4 support

• Solid mode for *.tls

• Dollhouse mode for *.tls

• Color mode for *.las
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25.1.2 Improvements

• Improved *.tls rendering performance

• Ability to add intermediate edges to polygons/polylines

• GUI for animated tours

• New GUI for *.kml

• Improved “Mask” tool performance

• Improved raster maps import master

25.1.3 Bugfixes

• No reloading while moving layers between folders

• Solid *.obj, *.3ds, *.dae 3d models are displayed correctly

• Coordinate system parameters are read from file metadata

• The key combination CTRL + A (selection of all objects), works in all text boxes

• Fixed errors arising from the construction of isohyps

• All generated *.dxf files are read in AutoCAD and other CAD systems.

• The sky is correctly displayed on the screenshots and rendered videos

• Export part of *.tls works without any errors

• Files with an uppercase extension supported

• There is no error in the absence of access to the project layers

• The trajectory of the animated tour smoothes correctly
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